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Building success beyond the classroom




The School District of Pickens County

Technology Proficiency Exam

Version 5
November 29, 2007
In order to be Technology Proficiency, you must complete this two part test with at least 80% accuracy.  This exam consists of two parts:  one part is demonstration and the other part is a test that has multiple-choice questions and true/false questions.  All questions are taken from Word 2007, Excel, PowerPoint, Activstudio, Outlook and basic Window operations.  These are the programs our district supports and the programs used in our district to communicate and enhance the classrooms.  You may use the computer to help answer any part of this exam.  The value for each part of this test is listed in parenthesis beside the instructions.

Multiple choice  - Choose the correct answer based on the software we use in our district.  (1 point each)  

1. For which of the following tasks would you use a word processor?

a. Creating a graph  (In WORD 07, under insert there is add a chart which has a link to Excel, and creates a graph….should this be changed?)  Suggestion-Sharing a flipchart
b. Averaging your grades

c. Writing a report

d. Drawing a picture

2. What monitors the work you are doing and anticipates when you might need help and then appears on the screen with tips?

a. Link

b. Dialog box

c. Office Assistant

d. Home page

3. Where would you find the Save As command in Word 2007?
a. Under the Home tab 

b. Under the Add-Ins tab 

c. Under the Microsoft Office Button 

d. On the ribbon 

4. Which of the following is not a Font Effect in Word 2007?
a. Case

b. Subscript

c. Strikethrough

d. Shadow  
5. When you press Ctrl+Home you go to the 

a. Pane

b. Splitting windows

c. Beginning of the new document

d. Mail Merge

6. Text printed at the top of the page is called a(n)
a. Header

b. Footer

c. Footnotes

d. Endnotes

7. Formatting text refers to:

a. Changing type and style of letters

b. Setting margins to ½”

c. Inserting clip art

d. Printing a document

8. Which tool would you use to find a synonym for a word?

a. Copy

b. Paste

c. Spell Check

d. Thesaurus

9. If you intend to type the word ‘time,” which of the following words would spell check identify as incorrect?

a. tmie

b. times 
c. timed

d. timing

10. In the examples below, the words in black are:


	Congress cannot set up an official religion for the country or pass laws to stop people from following their own religion.

Congress cannot make laws that stop people from speaking or writing what they wish.

Congress cannot make laws that stop people from holding peaceful meetings or from asking the government to correct a wrong.




a. Highlighted (Selected)

b. Bolded

c. Italicized

d. Underlined

11. The clipboard is:

a. Hard drive storage space

b. Temporary memory

c. A floppy disk

d. A sticky note

12. Which of the following is a font name?

a. Bold

b. Times New Roman

c. 12 pt

d. Center

13. Which of the following is not an alignment?

a. Left

b. Right

c. Italic

d. Center

14.  Which key would you press to indent a paragraph?

a. Tab

b. Shift

c. Enter

d. Up Arrow

15.  Which of the Tabs illustrated below would you choose to change the page layout from portrait to landscape?
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a. Home tab

b. Insert

c. Page layout

d. View

16.  If you want to add clip art to your document which of these steps would successfully insert that clip art into your document.

a. Click on Insert tab-select insert index-select collection
b. Click on view tab-select document map-search for picture

c. Click on insert-select Clip Art-fill in search for-press go-double click on art

d. Click on insert-select Clip Art-press shift V
17.  In the Home tab, the ribbon has a label titled Paragraph, see the illustration.  What are these buttons for?
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a. Make a table

b. Insert clip art

c. Spacing

d. Aligning  text

18. What type of text has a full blank line between each line of text?

a. Single-Spaced

b. Indented

c. Double-Spaced

d. Paragraph  

19.  The following picture shows an arrow to a button that would:
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a. Change a font

b. Quick save a a document

c. Spell check a document

d. Connect to the Web

20. Which alignment would you usually use for a report title?

a. Left

b. Right

c. Justified

d. Center

21. To create a newsletter, which of the following page set ups would be selected?

a. Pictures

b. Columns

c. E-mail

d. Puzzles

22. Which of the following programs would you use to create an original graphic?

a. Spreadsheet

b. Draw or paint program

c. Word processing

d. Database

23. Which of the following is a page orientation option?

a. Landscape

b. Vertical

c. Picture

d. Preview

24. What would you use to save a file for the first time?

a. Save

b. Locate File

c. Save As

d. Save File

25. Clicking the Print icon, if set up on the Quick Access bar, causes Word to:

a. Begin printing immediately using the default setting

b. Display the Print dialog box

c. Switch to the Print Preview screen

d. Show the document on the screen as it will appear when printed

26. In Print Preview, the insertion point changes to a :

a. Pointer

b. Magnifying Glass

c. I-Beam

d. Hand

27. Using the Show/Hide (¶) command, you can view hidden:

a. Orphans

b. Formatting Characters

c. Window Panes

d. Bullets

28.  To minimize the ribbon in WORD 2007:
a.  Double click on the ribbon

b. Right click on the tab bar or the Microsoft button

c. Press control B

d. Select page layout and then size


29. An e-mail address is made up of a user name and an address separated by what symbol?

a. >

b. #

c. /

d. @

30. A quick way to respond to the person who sent you an e-mail message is to send:

a. A carbon copy

b. An attached file

c. A reply

d. A post card

31. Typing an e-mail message to someone is similar to using a:

a. Word processor

b. Spreadsheet

c. Database

d. Paint program

32. A tool that allows you to conduct a search on the Internet is called a search:

a. Catalog

b. Engine

c. Motor

d. Book

33. Which of the following is a software program that allows you to view web pages on the Internet?

a. Word processor

b. Database

c. Browser

d. Spreadsheet

34. To keep a permanent record of web sites that you visit frequently, use:

a. Post office boxes

b. Bookmarks or Favorites
c. Locations

d. Bold text

35. To conduct a search on the Internet, which of the following would you use to find the topic of the search?

a. Looker

b. Handle

c. Address

d. Keyword

Questions 36 – 37 refer to the picture below.
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36. This arrow identifies the:

a. Open File 

b. Spell Check
c. Save As

d. Print

37. This arrow identifies the:

a. Resize tool

b. Title bar

c. Line spacing tool

d. Hard disk drive

38. This arrow allows you to:
a. Resize 
b. Add footnotes
c. Add a window

d. Add borders
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39. The letter A identifies the:

a. Current directory

b. List of folder/file names

c. Types of files

d. Change directory tool

40.  The letter B identifies the:

a. Current directory

b. List of file names

c. Types of files

d. Change directory tool

41.  The letter C identifies the:

a. Current directory

b. List of folder/file names

c. Types of files

d. Change directory tool

42. The letter D identifies the:

a. Current directory

b. List of file names

c. Types of files

d. Change directory tool

43. If your file is not in the current directory, you could use the _____________to try to locate it.

a. Current directory

b. List of file names

c. Types of files

d. Change directory tool

Questions 44- 46 refer to the picture below.
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44. The letter A identifies the following:


a. Directory tree

b. Floppy disk drive

c. Hard disk drive

d. Current (opened) directory

45. The letter B identifies the following:


a. Directory tree

b. Floppy disk drive

c. Hard disk drive

d. Current (opened) directory

46. The letter C identifies the following:


a. Directory tree

b. Floppy disk drive

c. Hard disk drive

d. Current (opened) directory

47. Column headings in a spreadsheet are labeled with:

a. Numbers

b. Letters

c. Greek symbols

d. Roman numerals

48. When entering formulas in a spreadsheet, you must always start with what symbol?

a. +

b. =

c. .

d. }

49. To add the values in cells B2 and C4, which of the following formulas should be entered?

a. B2-C4

b. +B2:C4


c. =B2+C4

d. =B2*C4

50. A group of highlighted cells is called a: 

a. Graph

b. Cell range

c. Cell address

d. Field

51. For which of the following is a formula used?

a. Calculate numbers

b. Make a graph

c. Draw a picture

d. Enter data

52. To create a graph, you must first ___________ the cells containing the data you want to graph.

a. Align

b. Highlight

c. Bold

d. Center

53. Which pair of letters identifies the axes on the graph?

a. X and Y

b. A and B

c. C and D

d. V and W

54. The School District of Pickens County uses the following e-mail system:
a. Yahoo

b. Google

c. Outlook

d. Netgear

Use the picture below to answer questions 55 – 56.
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55. The letter A identifies the following:
a. Send Message  (Changed the correct answer on this question from delete file to Send Message)
b. File Attachment

c. Delete Message

d. Directory

56. The letter B identifies the following:

a. Send Message

b. File Attachment

c. Delete Message

d. Directory

True/False (1 point each)

57.  In Activistudio Library, you can open a flipchart already created by dragging them onto a blank flipchart.
a. True

b. False

58.   In Activstudio, the letter T on the Main Toolbox is the add Teacher notes box.
a. True

b. False

59.  In Activistudio, the shared library contains a background button for easy insertion of backgrounds created by others.
a. False

b. True

60.  In Excel, a cell is the intersection of a row and a column.

a. True

b. False

61.  In Excel, a series of number signs (#######) appearing in a cell indicates that the data is wider than the column.

a. True

b. False

62. The data in a worksheet can be moved or copied to another location by using the Cut, Copy, Paste, and Fill commands on the Edit menu.  

a. True

b. False

63. The NOW() function will insert either the current date and current time into a spreadsheet cell.

a. True

b. False

64. Data in a worksheet can only be sorted numeric order.

a. True

b. False

65. A scatter chart produces a “cloud” of data points not connected by lines.
a. True

b. False

66.  In PowerPoint, slide transition is how one slide is removed from the screen and the next one appears.

a. True

b. False

67. You can create tables and graphs in PowerPoint.

a. True

b. False

68. Charts are graphical representation of worksheet data

a. True

b. False

69. Line Charts are good for representing trends over a period of time.

a. True

b. False

70. While you are connected to Outlook, you will be notified of any new messages to your mailbox with a red flag.

a. True

b. False  
Complete the two following demonstration activities.  (15 points each)

71. Open Microsoft Word 2007 and type the brief document that is at the bottom of this page. 

a. Center the title and format the font for the title to bold and 14-point size. 

b. Type your name under the title.

c. Copy the first sentence and paste it as the last sentence of the document.

d. Add your name (first and last) to the end of the document.

e. Right-align your name.

f. Check your document for any spelling and grammar errors.  Make the necessary corrections.
g. Save the document.

h. Print the document using landscape orientation. 

i. Attach the document you printed to your test.

72. Open your Outlook mailbox.
a. Create an e-mail message with the subject “Technology test.”

b. Attach the file you saved and printed in question 71.

c. Send the e-mail message with the attachment to your test administrator (TRT).

Document for Question 71.

Formative Assessment Goal-Setting

The first and most essential steps in creating a formative assessment program are goal setting and design.  Districts generally have at least one of three primary purposes for developing and implementing a formative assessment program:

· Informing instruction in the classroom

· Charting student growth throughout the school year

· Predicting student performance on state assessments

These three goals are not mutually exclusive.  However, educators and districts often need assistance in evaluating the balance necessary to achieve these goals.
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